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Introduction 
 
This manual will detail most of the menu options found in the Word 2003 menu Insert.  
The Insert menu options discussed in this manual are: 

◘ Break 
◘ Page Numbers 
◘ Date and Time 
◘ Auto Text 
◘ Symbols 
◘ Comment (fyi)  
◘ Reference 
◘ Picture 
◘ Diagram 
◘ Text Box 
◘ File 
◘ Object 
◘ Bookmark 
◘ Hyperlink 

 
Each menu item will be defined and will provide reasons to use that particular menu 
option.  Following the background information, there will be a Step-by-Step that will 
provide instruction on how to use the tools and commands.  Some processes that you 
perform from the menu, can also be done other ways.  If there is an Alternative method, 
this would be the last part of each lesson. 
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Break 
 
Definitions 
Word Definition 
Page Break Allows you to add a forced break at the insertion point. 

 
Section  A section is a part of a document defined by a section break that 

can contain different Page Setup options, headers and footer, and 
other formatting.  
 

Section Break (Per Microsoft Help)  A section break is inserted to show the end of 
a section.  A section break stores the section formatting elements. 
 

Section Break- 
Next Page 

(Per Microsoft Help) Inserts a section break and breaks the page so 
that the next section starts at the top of the next page. 
 

Section Break- 
Continuous 

(Per Microsoft Help) Inserts a section break and starts a new section 
without inserting a page break. 
 

Section Break- 
Even Page 

(Per Microsoft Help) Inserts a section break and starts the next 
section on the next even-numbered page. 
 

Section Break  
Odd Page  

(Per Microsoft Help) Inserts a section break and starts the next 
section on the next odd-numbered page. 
 

 
Why would you use this? 

◘ To insert a manual page break at the end of text on a page.  This will prevent 
items from “moving” when printed. 

◘ To add a forced break after a section or chapter in your document. 
◘ To create different headers and footers for different parts of a document. 
◘ To make the first page of a document different than the rest of the document. 
◘ To have different parts of a document landscape and other portrait. 
◘ To use columns in one part of document and no columns in other sections. 
◘  

 
Step by Step- Page Break 
 

What you do What happens 

1. Place the insertion point where you 
want the page break to appear. 
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What you do What happens 

2. From the menu choose: 
Insert, Break 
 
(Text wrapping break- Ends the 
current line and forces the text to 
continue below a picture, table, or 
other item.  The text continues on 
the next blank line that does not 
contain a table.) 

The Break box displays. 

 
 

3. Click in the radio button for Page 
Break. 
 
Click on the OK button. 
 
If you have the Show/Hide  
tool on you will see a line with 
“Page Break” in the middle. 
 

An example of a page break. 

 

 
 
Alternative Methods 

What you do What happens 

1. To insert a page break, place the 
cursor where you want the break to 
be.  
 
Use the keyboard command of 
Ctrl + Enter. 
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Step by Step- Section Break 
 

What you do What happens 

1. Place the insertion point where you 
want the section break to appear. 
 

 

2. From the menu choose: 
Insert, Break 

The Break box displays. 

 
 

3. Click in the radio button for the 
type of section break that you want 
to insert. 
 
Click on the OK button. 
 
If you have the Show/Hide  
tool on you will see a line with 
“Section Break”. 

An example of a section break. 

 
 
Note the section breaks in the example. 
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Page Numbers 
 
Why would you use this? 

◘ To quickly add the page number to the entire document in the Header or 
Footer. 

◘ To add page numbers to the document without adding a page number to the 
first page. 

◘  
 
Step by Step 
 

What you do What happens 

1. From the menu choose: 
Insert, Page Numbers 
 

The Page Numbers box displays. 

 
 

2. In the Position field, you can 
select Bottom of page (Footer) or 
Top of page (Header).  This will 
put the page number in the top or 
bottom margin.   
 

 

3. In the Alignment field, you can 
select Right, Left, Center, Inside, 
or Outside.   
 
The Inside and Outside options 
allow you to create a “mirror” 
effect for manuals. 
 

The Alignment option of Inside Preview: 
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What you do What happens 

4. You can have the page number not 
shown on the first page by 
removing the check in the Show 
number on first page box. 
 
However, this will number the next 
page (page 2) as page 2 and not 
page 1.  This may not work if you 
are using page 1 as a title page and 
want the first actual page of the 
manual to be shown as “Page 1.” 
 
See the Tip in step number 6. 
 

 

5. You can format the page number 
by clicking on the Format button. 
 

The Fomat box displays. 

 
 

6. Tip:  To not show a page number 
on the first page and to start the 
page numbering on 1 (which is 
“page 2” according to Word) you 
will need to clear the checkmark in 
the Show number on first page 
box.   
 
Then, click on the Format button 
and select the option for Start at 
and enter a 0 (zero).  Click on OK.
 

 

7. Note:  When you use this option to 
insert a page number, the page 
number is inserted in a text box. 
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Alternative Methods 

What you do What happens 

1. Choose from the menu: 
View, Header and Footer 
 

The Header and Footer areas open as well as the Header 
and Footer toolbar. 

 

2. Use the Insert Page Number  
icon to insert page numbers in the 
entire document. 
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Date and Time 
 
Why would you use this? 

◘ To insert a date or time into your document for a letter, memo, footer, notes, 
etc. 

◘ To insert a date or time that will remain static. 
◘ To insert a date or time that will update each time you reopen the document. 
◘  

 
Step by Step 
 

What you do What happens 

1. Place the insertion point where you 
want the date to appear. 
 

 

2. From the menu choose: 
Insert, Date and Time 
 

The Date and Time box displays. 

 
 

3. In the Available formats frame, 
you can select a format for the date 
and time. 
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What you do What happens 

4. If you want the date/time to remain 
static, clear the checkbox for 
Update automatically.  
 
If you want the date/time to update 
each time you open the document, 
put a checkmark in the Update 
automatically checkbox.  This 
field is independent from the 
Header/Footer. 
 

 

 
Alternative Methods 

What you do What happens 

1. To enter a date into a document 
you can utilize Words Auto 
Complete feature.   
 
The date will be formatted as 
follows: 

 
 
To enter the current date start 
typing the month and a tip will 
appear above your typing: 

Press the Enter key to insert the 
complete date.  
 

 

2. If you want to enter a month 
different from the current date, 
type the first four letters of the 
month. 

 
The tip will appear again.  Press 
the Enter key to accept the month.
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What you do What happens 

3. If auto complete is not working, 
make sure that the option is turned 
on. 
 
Choose from the menu: 
Tools, AutoCorrect Options 
 
Go to the AutoText tab. 

The AutoText tab displays. 

 
 

4. Put a checkmark in the Show 
AutoComplete Suggestions.   
 
Click on the OK button. 
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Auto Text 
 
Definitions 
Word Definition 
Auto Text (Per Microsoft Help) A storage location for text or graphics you 

want to use again, such as a standard clause or a long distribution 
list.  Each selection of text or graphics is recorded as an Auto Text 
entry and is assigned a unique name.  Word comes with a number 
of built-in AutoText entries, such as salutations and closings for 
letters, and you create your own AutoText entries. 
 

 
Why would you use this? 

◘ To insert routine text in a quick and efficient manner. 
◘  

 
Step by Step 
 

What you do What happens 

1. Place the insertion point where you 
want the text to appear. 
 

 

2. From the menu choose: 
Insert, AutoText 
 

The menu item expands to a submenu. 
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What you do What happens 

3. To insert a Closing, Signature, 
Subject Line, etc move the cursor 
over the respective menu selection.
 
Then, make the final selection that 
you would like added to your 
document.  
 

 

4. You can also select the submenu 
option of AutoText. 
 

The AutoCorrect box opens on the AutoText tab. 

 
 

5. This tab will allow you to add your 
own AutoText entries.  
 
Enter the text you want saved in 
the Enter AutoText entries here 
field. 
 
Click on the Add button and then 
the OK button. 
 

 

6. Any added AutoText entry can be 
found in the submenu Normal. 
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What you do What happens 

7. Tip:  You can make the AutoText 
submenu into a floating toolbar.  
To do this, put the cursor over the 
top of the menu.  You will see a 
horizontal thick line at the top.  
The cursor will also change into a 
four way arrow.  With the left 
mouse button down, pick up the 
submenu and drag and drop to 
anywhere in the Word window. 
 

The menu with the horizontal bar circled: 
 
 

 
 

 
Alternative Methods 

What you do What happens 

1. To enter an AutoText entry you 
can also start typing the text (about 
the first four letters) and a screen 
tip will appear. 

 
 

 

2. To insert the AutoText entry, press 
the Enter key. 
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Symbols 
 
Why would you use this? 

◘ To insert special symbols into a document such as: 
 
☺©♫� ¶@n;���  

◘  
 
Step by Step 
 

What you do What happens 

1. Place the insertion point where you 
want the special character to 
appear. 
 

 

2. From the menu choose: 
Insert, Symbol 

The Symbol box displays. 

 
 

3. You can adjust the Font to see 
additional characters.   
 
You can use the scroll bar to scroll 
through the various subsets. 
 

 

4. When you have located the symbol 
that you want to use, select it and 
click on the Insert button. 
 
You can also double click with the 
mouse on the symbol to insert it. 
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What you do What happens 

5. You can also insert Special 
character by advancing to the 
Special Character tab. 
 
A special character is a symbol 
such as a Copyright© or 
Trademark ™. 
 

The Special Character box displays. 

 
 

6. Tip:  If you are going to be 
inserting several symbols you can 
keep the Symbols box open while 
you change the location of the 
insertion point.   
 

 

 
Alternative Methods 

What you do What happens 

1. You can use the AutoCorrect 
feature to automatically insert 
certain symbols.   
 
You can type using keyboard keys 
and your entry will automatically 
be replaced by the symbol. 
 

 
Enter  To Insert 
(c) © 
(r) ® 
(tm) ™  
:) ☺ 

:( / 

--> Æ 

 
 

2. If your entry is not replaced, 
choose from the menu Tools, 
AutoCorrect Options. 
 
On the AutoCorrect tab select the 
checkbox for Replace test as you 
type. 
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Comment 
 
Definitions 
Word Definition 
Comment (Per Microsoft Help)  A note or annotation that an author or 

reviewer adds to a document.   
 

 
 
Why would you use this? 

◘ To add notes to a document you are reviewing for another person. 
◘ To add discrete notes to a document you are working on. 
◘  

 
Step by Step 
 

What you do What happens 

1. Place the insertion point where you 
want the comment to appear. 

 

2. From the menu choose: 
Insert, Comments 
 

The Reviewing toolbar, the Reviewing pane, and a 
comment balloon displays. 

 
 

3. If the comment balloon does not 
display, you can turn this on by 
selecting from the Reviewing 
toolbar: 
Show, Balloons, Only for 
Comments/Formatting 
 

 

Reviewing 
Pane 

Comment 
Balloon
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What you do What happens 

4. If the you do not want the 
Reviewing pane displayed, you can 
turn this off (or on) by selecting 
from the Reviewing toolbar: 
Show, Reviewing Pane 
 

 

5. After you select Insert, Comment 
from the menu you can type the 
comment.   

 

6. After you enter comments, your window will look similar to the following: 

 
 

7. To view the comment, rest the cursor 
over the highlighted text. 
 

 

8. Note:  the note or indicator will not 
print. 
 

 

9. Tip:  To continue working on your 
document, turn off the Reviewing Pane 
and the Balloons.   
 
You will still have an indication of the 
comment that will display as follows: 
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What you do What happens 

10. To edit or delete a comment, right click 
with the mouse over the comment. 

 
 

 

11. Note:  To learn more about Comments 
and the other Reviewing Tools, see the 
separate Word manual for this topic. 
 

 

 
 
Alternative Methods 

What you do What happens 

1. You can use the Reviewing toolbar 
to insert comments.  
 
Open the Reviewing toolbar.  
Then, use the Insert Comment 

icon. 
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Reference 
 
Definitions 
Word Definition 
Footnote (Per Microsoft Help)  A footnote is used in printed documents to explain, comment 

on, or provide references for text in a document.  Footnotes corresponding notes are 
found at the bottom of the page with the referenced text.  
 

Endnote (Per Microsoft Help)  An endnote is used in printed documents to explain, comment 
on, or provide references for text in a document.  Endnotes corresponding notes are 
found at the end of the document. 
 

Note 
Reference 
Mark 

This is the notation in the documentation that is used to refer a reader to the endnote 
or footnote.  It can be formatted in various ways, but usually is shown as a number 
or roman numeral.  
 

Caption (Per Microsoft Help)  A caption is a numbered label, such as “Figure 1” that you can 
add to a table, figure, equiation, or other item. 
 

Cross 
Reference 

(Per Microsoft Help) A cross-reference refers to an item that appears in another 
location in a document—for example, "See Figure 1." You can create cross-
references to headings, footnotes, bookmarks, captions, and numbered paragraphs. 
 

Styles Pre-set formatting applied to a selected group of text.  There are 9 different bulit in 
styles in Word- Heading 1- Heading 9. 
 

 
 
Why would you use this? 

◘ To further explain something from your document. 
◘ To cite sources. 
◘ To provide a definition for a term in your document. 
◘ To add Figure 1, Table 1, Picture 1, etc. to items in the document. 
◘  
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Step by Step- Footnote (&Endnote) 
 

What you do What happens 

1. In print layout view, click where 
you want the note reference mark 
to be. 
 

 

2. From the menu choose: 
Insert, Reference, Footnote 
 

The Endnote and Footnote box displays. 

 
 

3. In the Location section of the box, 
click on the radio button for the 
type of note you want to use 
(Footnotes or Endnotes). 
 

 

4. In the Format sections of the box, 
verify the Number format that you 
want (numbers, roman numerals, 
letters, etc). 
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What you do What happens 

5. Click on the Insert button to insert 
the note reference mark. 
 

The note reference mark is inserted and the cursor goes to 
the end of the page (or document for Endnotes).  The 
cursor is automatically in the correct location.  Type the 
note. 

 
Note that there is a line above the notes. Regardless of the 
type of notes you used, this line will be present above the 
first note. 
 

6. To edit the notes for any footnote 
or endnote, simply go to the note 
(at the end of the page or end of 
the document) and edit the text. 
 

 

7. After you have the endnotes or 
footnotes created you can still 
make changes.  To make changes, 
such as the format of the numbers, 
make your changes on the 
Footnote and Endnote box and 
click on the Apply button. 
 

 

8. Tip:  To see what is currently in 
the notes for an endnote or 
footnote, place the cursor over the 
reference mark.  The cursor will 
change to look like a comment and 
it will display the text. 
 

 

9. Tip:  If you are entering your notes 
at the bottom of the page or at the 
end of the document and you want 
to go to the reference mark in the 
document, you can double click 
over the number, roman numeral, 
letter, etc.  This will take you to the 
location in the document where 
you created the endnote or 
footnote. 
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Step by Step- Caption 
 

What you do What happens 

1. Select the item that you want to 
add a caption to. 
 

 

2. From the menu choose: 
Insert, Reference, Caption 
 

The Caption box displays. 

 
 

3. If you are going to add the label of 
Figure, Table, or Equation you can 
select from the Label drop down.  
 

 

4. If you want to change the location 
of the label from the default 
location of Below the selected 
item, to Above use the Position 
drop down.   
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What you do What happens 

5. To create a custom label, click on 
the New Label button.  
 
Add the text for the label and click 
on the OK button. 
 

The New Label box displays. 

 
| 
The Caption box displays again with the new custom 
label. 

 
 

6. Click on the OK button again to 
return to your document. 
 

The document displays with the label. 
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What you do What happens 

7. If you want to automatically insert 
captions, you can turn the option 
on for AutoCaption. 
 
From the menu choose: 
Insert, Reference, Caption 

The Caption box displays. 

 
 

8. Click on the AutoCaption button. 
 

The AutoCaption box displays. 

 
 

9. In the Add caption when 
inserting list, select the objects for 
which you want Microsoft Word to 
insert captions.  

 

10. In the Use label drop down, select 
an existing label. If the list does 
not provide the correct label, click 
the New Label button, type the 
new label in the Label box, and 
then click OK. 
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What you do What happens 
11. Click on the OK button again to 

return to the document. 
 

12. In your document, insert the object 
(Insert menu, Object command).  
 
Word automatically adds the 
appropriate caption and a 
sequential number whenever you 
insert one of the objects that you 
selected in step 3. 

 

 

13. Tip:  If you want to add additional 
text to the label, click on the text 
with the mouse and insert text 
where desired.  
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Step by Step- Index and Tables (Table of Contents) 
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What you do What happens 

1. In order to successfully create a table of contents you must use Styles in Word.  (You can use 
another tool, Outlining, but in this manual only the method for creating a table of contents with 
styles will be documented.) 
 
When you generate a table of contents, Word is pulling the styles automatically and will create a 
list of the text and page numbers. Furthermore, the table of contents serves as links to the 
respective pages in the document. You can also update a table of contents if you make changes 
with a simple right click on the mouse! 
 
As example: 

 
 

The resulting table of contents from this example document: 

 

Style:  Heading 1 

Style:  Heading 2 

Style:  Heading 2 
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What you do What happens 

2. Your document should already 
have styles (you used them in your 
development of the document) or 
you can go back after you created 
the document and add styles.   
 

 

3. Place the insertion point where you 
want the table of contents to 
appear. 
 

 

4. From the menu choose: 
Insert, Reference, Index and 
Tables 
 
Click on the Table of Contents tab.
 

The Index and Tables box displays. 

 
 

5. The defaults for Show page 
numbers, Right align page 
numbers, Tab leader, and Use 
hyperlinks instead of page 
numbers all work well for a table 
of contents. 
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What you do What happens 

6. Click on the Options button. 
 
 
Note:  If you are using custom 
styles, be sure to remove the 
number in the TOC level column 
for the non-used built in Word 
styles (Heading 1, Heading 2, etc).  

The Table of Contents Options box displays. 

 
 

7. In the Available Styles frame, find 
the styles you have applied to 
headings in your document.   
 
In the column under the TOC level 
heading, enter a number from 1-9 
(the total number of built in 
Heading Styles).  This will indent 
the headings in the table of 
contents according to the level you 
indicate. 
 
Click on the OK button and OK 
again. 
 

The table of contents displays. 
 

 

8. To change the look of the table, 
you can select a different design by 
selecting another option from the 
Formats down arrow.  
 

The same table of contents, but with the Formal format: 

 
 

Level 2

Level 1
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What you do What happens 

9. You can change the formatting of a 
line by going to the end of the line, 
after the page number, and triple 
click.  This will select the line.  
Make whatever change desired.  
Whatever level you change the 
formatting on, all other entries at 
this level will also change. 
 

 

10. To update the table of contents 
after you have already generated it, 
put the cursor over the table and 
right click with the mouse. 
 

The short menu displays. 

 
 

11. Select Update Field. 
 

The Update Table of Contents box displays. 

 
 

12. Select the appropriate radio button.
 
If you made changes that only 
impact the page numbers, select 
the first option.  
 
If you made lots of changes with 
text, pages, insertions, deletions 
choose the second option. 
 
Click on the OK button. 
 

The table of contents will update. 
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Picture 
 
Definitions 
Word Definition 
Word Art WordArt is clip art that combines text and graphics together.  

WordArt allows you to create fancy text objects that have added 
dimension, color, and style.  After you insert them, they work like 
most other objects in Word.  You can select them, resize them, and 
make formatting changes. 
 

 
Why would you use this? 

◘ To add pictures or graphics to a document. 
◘ To create a newsletter or brochure. 
◘ To add the University or a Department logo to a document. 
◘  

 
Step by Step- Clip Art 
 

What you do What happens 

1. Place the insertion point where you 
want the clip art to appear. 
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What you do What happens 

2. From the menu choose: 
Insert, Picture, Clip Art  
 

The Clip Art Task Pane displays. 

 
 

3. You can search by keyword in the 
Search for field.  You can search 
using more than one word as well.  
 
You can use the Search in field to 
select where you want to search. 
 
You can use the Results should be 
field to choose what type of clip art 
you want to search for (clip art, 
photographs, movies, or sounds). 
After you enter search criteria, 
select the Go button. 

 

The Clip Art Task Pane returns the search. 
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What you do What happens 

4. Click on the picture once to insert 
the picture into the document.   

 
You can also place the cursor (not 
pressing, just resting over) over the 
right side of the picture and a gray 
bar with an arrow appears.  If you 
click on this arrow a short menu 
returns with various options. 
 

The menu: 
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What you do What happens 
Tip:   
The easiest way to resize an image is by dragging its edges to match the size and shape that 
you want.  To do this, click on the image once to select it.  A box will appear around the 
image with eight sizing handles.  The handles have different meaning and they are as 
follows: 

• Dragging the corner handles resized your image diagonally, keeping the 
proportions of the image the same. 

• Dragging the middle handles resize the object only vertically or horizontally 
depending on which handle you are using.  This option will strech the image out 
of its proportions. 

 
You can also size an image by using the Format Picture box.  To open this box, 
select the image and right click with the mouse to get the short menu. From the short 
menu, select Format Picture.  Advance to the Size tab. 

 

 
 

Make changes and select the OK button. 
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What you do What happens 
Tip:   
After you insert a piece of clip art into your document you can change the appearance by 
changing the text wrapping, the border, the color of the border, and many other things to 
make the image look just how you want it to.  If you click on the clip art to active it, the 
Picture toolbar should display.  You can also open the Picture toolbar by using the menu 
option of View, Toolbars, Picture.   
 

 
 
In order as they appear, the icons on the Picture toolbar are as follows: 

1. Insert Picture:  Insert a picture. 

2. Color:  Change to grayscale, black and white, or washout. 

3. More Contrast:  Sharpen the image contrast. 

4. Less Contrast:  Reduce the image contrast. 

5. More Brightness:  Brighten an image. 

6. Less Brightness:  Darken an image. 

7. Crop:  Trim the picture by taking part of image off. 

8. Line Style:  Change the border of the image. 

9. Compress Picture:  Control the file size of image. 

10. Text Wrapping:  How text wraps around the image. 

11. Format Picture:  Opens Format Picture box for formatting changes. 

12. Set Transparent Color:  Removes one color from image. This is not available on 

all images. 

13. Reset Picture:  Returns picture to original state. 
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Alternative Methods 
What you do What happens 

1. Using the Drawing toolbar, click 

on the Insert Clip Art  icon. 
 

 

2. In any of the Task Panes, you can 
select from the drop down arrow at 
the top, Clip Art.  
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Step by Step- From File 
 

What you do What happens 

1. Place the insertion point where you 
want the picture from file to 
appear. 

 

2. From the menu choose: 
Insert, Picture, From File 
 

The Insert Picture box displays. 

 
 

3. Locate the picture by using the 
Look in field or the shortcut 
buttons on the left.  
 
Click once on the file to select it 
and select the Insert button. 
 
You can also double click on the 
file to insert it.  
 

 

4. You can use the information in the 
last section (Insert Clip Art) to 
modify the picture. 
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Step by Step- AutoShapes 
 

What you do What happens 

1. From the menu choose: 
Insert, Picture, AutoShapes 
 

The AutoShapes toolbar displays. 

 
 

2. Click on an icon for the type of 
AutoShape you want to insert.   
 
Another menu will drop down with 
specific AutoShapes.  Click on the 
desired shape. 
 

The additional selections: 

 
3. To insert the shape with a 

predefined size, click anywhere in 
the document one time.  This will 
create an object that is about 1” by 
1”. 
 
To insert a customized sized shape, 
drag with the mouse, the shape to 
the size you want.  
 
Tip:  Hold down the Shift key 
when dragging the shape to 
prevent distortion. 
 

An AutoShape object: 

 

4. Note:  The default wrapping style 
for AutoShapes is In front of text.
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What you do What happens 

5. Note:  On some objects there are 
green circles and yellow diamonds.  
These are tools that will allow you 
to change the appearance of the 
object.   

 
� Green Circle:  The green 

circle is the Free Rotate tool 
which will allow you rotate the 
object to any angel.  To use 
this tool, drag the handle in the 
direction that you want the 
object rotated. 

� Yellow Diamond:  The yellow 
diamond is the Adjustment 
Handle which will allow you 
to adjust the curve of a line.  
To use this tool, drag the 
handle in the direction you 
want the curve adjusted.  Not 
all AutoShapes have this 
option. 
 

 

6. You can make the shape larger or 
smaller by using the sizing 
handles. 

 

 

7. You can insert text into some 
shapes.  To do this, right click on 
the shape and select Add Text. 
 

Examples: 
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What you do What happens 

8. You can shade the shape or change 
the borderline color by using the 
Fill Color and Line Color 

 icons from the 
Drawing toolbar. 

 

Examples: 

 
9. You can change the line style of 

the border of the shape by using 
the Line Style or Dash Style 

 icons from the Drawing 
toolbar. 

 

Examples: 
 

 
 
 
Alternative Methods 

What you do What happens 

1. Using the Drawing toolbar, click 
on the AutoShapes button and 
then point to the category of 
choice, and then click on the shape 
you want. 
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Step by Step- Word Art 
 

What you do What happens 

1. Place the insertion point where you 
want the Word Art to appear. 
 

 

2. From the menu choose: 
Insert, Picture, Word Art 

The Word Art box displays. 
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What you do What happens 

The WordArt toolbar becomes active once you insert a piece of WordArt. 

 
 

:  Insert New WordArt 

:  Edit the text in the current WordArt 

:  Change the WordArt Style 

:  Format WordArt such as Colors and Lines, Size, and Layout 

:  Change the WordArt Shape 

:  Change the wrapping style of the WordArt 

:  Adjust the letters in WordArt to have the same height 

:  Adjust the WordArt to have vertical text 

:  Adjust the alignment of the WordArt 

:  Adjust the character spacing (horizontal space between characters) 
 

3. Click the style of WordArt you 
want and select OK. 

 

 

4. Enter the text and select the Font, 
Size and other attributes. 

 
Change the Font and Size of our 
name. 
 
Select OK. 
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What you do What happens 

5. The default text wrapping for a 
WordArt object is “In Line with 
Text”, which means the WordArt 
is placed at the insertion point in a 
line of text in the document.  The 
object remains on the same layer as 
the text. 

 
Therefore, to move the WordArt 
object you can leave the text 
wrapping and use the alignment 
tools on the formatting toolbar or 
you can adjust the text wrapping to 
allow you to use the drag and drop 
method.   

 

 

6. You can modify the WordArt 
using the tools on the Drawing 
toolbar such as the Fill Color and 

Line Color . 
 

 

 
 
Alternative Methods 

What you do What happens 

1. Using the Drawing toolbar, click 
on the Insert WordArt  icon. 
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Diagram 
 
Definitions 
Word Definition 
Organization Chart Shows a hierarchical relationship. 

 
Cycle Diagram Show a process with a continuous cycle. 

 
Radial Diagram Shows the relationship of core elements. 

 
Pyramid Diagram Shows a foundation based relationship. 

 
Venn Diagram Shows areas of overlap between areas. 

 
Target Diagram Show steps towards a goal. 

 
 
Why would you use this? 

◘ To create an Organization Chart. 
◘ To add a picture to explain a process or concept. 
◘  

 
Step by Step 
 

What you do What happens 

1. Place the insertion point where you 
want the diagram to appear. 
 

 

2. From the menu choose: 
Insert, Diagram 
 

The Diagram Gallery box displays. 
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What you do What happens 

3. Click on the diagram type you 
want and click on the OK button. 
 

The drawing canvas displays with the template for the 
diagram.  The example illustrated is for an Organizational 
Chart. 

 
 

4. A floating toolbar also displays. 
 
Note:  A toolbar will display for 
each type of diagram, but they 
differ. 
 

The Organization toolbar also displays. 

 
 

5. To add text, click in a text box 
where it says, “Click to add text.” 
 

The chart with text. 

|  
 

6. Use the toolbar to make any 
necessary adjustments or additions.
 

 

7. You can also make formatting 
changes by selecting the text and 
making any desired changes. 
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Alternative Methods 
What you do What happens 

1. You can click on the Insert 
Diagram or Organization Chart 

 icon on the Drawing toolbar. 
 

 

2. You can also choose from the 
menu: 
Insert, Picture, Organization 
Chart 
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Text Box 
 
Definitions 
Word Definition 
Text Box A text box is a graphic object that contains text.  It is often used to 

grab the attention of the reader.  You can format a text box with 
borders, shading, and you can add different colors and fonts.  Text 
boxes give you the freedom to put text in boxes that are on a 
separate layer from the text in your document.   
 

 
Why would you use this? 

◘ To add text anywhere on a page. 
◘ To change the direction of text. 
◘ Make text flow from one part of a document to another. 
◘  

 
Step by Step 
 

What you do What happens 

1. Place the insertion point where you 
want the text box to appear. 

 

 

2. From the menu choose: 
Insert, Text Box 
 

The Drawing Canvas displays. 
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What you do What happens 

3. To remove the Drawing Canvas, 
you can click on the Esc key.   
 
Tip:  To turn off the Drawing 
Canvas, you can go to Tools, 
Options.  On the General tab, 
uncheck the option for 
Automatically create drawing 
canvas when inserting 
AutoShapes. 
 

See note at the end of this section about the Drawing 
Canvas. 

4. The cursor becomes an arrow.  
With the mouse (hold down left 
mouse button) drag until the text 
box is big enough.  When you have 
the desired text box size, release 
the left mouse button. 
 

The text box displays. 

 

5. The Text Box floating toolbar also 
displays. 
 

The Text Box toolbar. 

 
 

6. Enter text and format as desired. 
 

The text box: 
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What you do What happens 

7. To rotate the text in the text box, 
click on the Change Text 

Direction  icon on the Text 
Box toolbar. 
 
Click on the icon until the desired 
direction appears. 
 

The text in a new direction. 

 
 

8. To adjust the size of the text box, 
move the cursor over the corners 
(or sides on the move handles – 
little circles) until a double arrow 
displays.  Drag and drop until the 
desired size is achieved. 
 

The text box reduced. 
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What you do What happens 

9. You can move the text box 
anywhere on the page.  First, select 
the text box.  Then, with the mouse 
drag and drop.   
 
The default wrapping style is, in 
front of text.  This means that 
wherever you drop the text box it 
will be placed over anything on the 
page.  
 
To adjust the wrapping, you can 
select the text box and right click 
with the mouse.  Be sure you are 
on the Layout tab. 

 
 
 
 
The Format Text box displays. 

 
 

10. You can also link the text in one 
text box to another text box.  This 
is done by linking the boxes.   
 
First, create the two text boxes.  
They do not have to be on the same 
page.   
 

An example of two text boxes. 

 
11. Click on the first text box to select 

it. 
  

 

12. On the Text Box toolbar, click on 

the Create Text Box Link  
icon. 
 

The cursor changes to appear as follows  
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What you do What happens 

13. Move the cursor over the second 
text box.  The cursor will appear as 

follows:    Click on the 
second text box.  
 

 

14. The two boxes are now linked.  If 
you type in the first text box until it 
is filled, you will automatically go 
into the next text box. 
 

The text flowing from one text box the other. 

 
 
Alternative Methods 

What you do What happens 

1. You can click on the Text Box 

icon on  the Drawing toolbar. 
 

 

 
 
Special Note: 
The drawing canvas extends from the left to the right margin and is 4.5” high.  To help 
you use the drawing canvas, there is a Drawing Canvas toolbar.  One way to show the 
toolbar is to right click inside the drawing canvas and select the option to Show Drawing 
Canvas toolbar. 

 
� :  Eliminates blank drawing canvas space beyond the edges of the drawing 

objects. 
 

� :  Expands the drawing canvas by ½ inch. 
 

� :  Changes the borders of the drawing canvas to small circles that 
will allow you to enlarge or shrink the drawing. 
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� :  Allows you to choose how text will wrap around the canvas (text 
wrapping). 
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File 
 
Why would you use this? 

◘ To incorporate another Word file into the current document.  
◘ In mail merge, you can use this to open an existing file for the merge such as a 

form letter. 
◘  

 
Step by Step 
 

What you do What happens 

1. Place the insertion point where you 
want the file to appear. 
 

 

2. From the menu choose: 
Insert, File 

The Insert File box displays. 

 
3. Locate the file using the Look In 

drop down or by using the 
shortcuts on the left.   
 

 

4. Click on the file to select it and 
then click on the Insert button. 
 

 

 
 
Alternative Methods 

What you do What happens 

1. An alternative would be to copy 
information from another 
document and paste into the 
working document.  
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Object 
 
Definitions 
Word Definition 
Object (Per Microsoft’s Help) A table, chart, graphic, equation, 

AutoShape, Picture, Clip Art, or other form of information.   
 

Linked Object (Per Microsoft’s Help) An object that is created in a source file and 
inserted into a destination file, while maintaining a connection 
between the two files.  The linked object in the destination file can 
be updated when the source file is updated. 
 

Source File (Per Microsoft’s Help) The file that contains information that was 
used to create a linked or embedded object.  When you update the 
information in the source file, you can also update the linked object 
in the destination file.  
 

 
 
Why would you use this? 

◘ To include information from files created in other Microsoft Office programs 
such as an Excel spreadsheet. 

◘  
 
Step by Step 
 

What you do What happens 

1. Place the insertion point where you 
want the object to appear. 
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What you do What happens 

2. From the menu choose: 
Insert, Object 
 
Click on the Create from File tab. 
 

The Object box displays. 

 
 

3. Click on the Browse button to 
locate the object file. 
 

The Browse box displays. 

 
 

4. Locate the object and click on the 
Insert button. 
 

The Object box displays again. 
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What you do What happens 

5. Click to place a check in the Link 
to file checkbox to create a linked 
object.   
 
Click in the Display as icon 
checkbox to insert an icon.  This 
icon, when double-clicked, will 
open the source file. 
 

 

6. Click on the OK button. 
 

The object displays. 

 
 
Alternative Methods 

What you do What happens 

1. You can use the Paste Special 
command found in the Edit menu. 
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Bookmark 
 
Definitions 
Word Definition 
Bookmark (Per Microsoft Help) A bookmark identifies a location or selection 

of text that you name and identify for future reference. 
 

 
 
Why would you use this? 

◘ Helps you to identify text that you may want to refer to at a later time. 
◘ To quickly advance to a certain section of a document. 
◘ Allows you to create a list of hyperlinks at the beginning of a document. 
◘  

 
Step by Step 
 

What you do What happens 

1. Select the item that you want to 
assign a bookmark or click with 
the mouse where you want to insert 
a bookmark. 
 

 

2. From the menu choose: 
Insert, Bookmark 
 

The Bookmark box displays. 

 
 



Word 2003: Insert Menu Option  The University of Akron 

 
Ver. 2005.09.27 Learning Technologies/Software Training Page 61 

©2005 The University of Akron.  These materials may not be reproduced in whole or in part without the express 
written permission of The University of Akron 

 

What you do What happens 

3. In the Bookmark name field, 
enter a name.  
 
Note:  The bookmark name must 
begin with a letter, but it can 
contain numbers.  Also, no spaces 
are permitted in bookmark names. 
 

The Bookmark box after you add a bookmark. 

 
 

4. Click on the Add button. 
 

The document returns. 
 

5. To refer back to bookmarks you 
have added, you can go back to the 
Bookmark box. 
Insert, Bookmark 
 

The Bookmark box displays with a list of all document 
bookmarks. 

 
 

6. Select the bookmark that you want 
to advance to and click on the Go 
To button. 
 

You advance to the bookmark location. 
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Alternative Methods 
What you do What happens 

1. To go to bookmarks, you can use 
the keyboard command of Ctrl + 
G. 

The Go To box displays. 

 

2. In the Go to what box, select 
Bookmark. 
 
In the Enter bookmark name 
field, use the drop down arrow to 
locate and select the bookmark 
name. 
 

You advance to the bookmark location. 
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Hyperlink 
 
Definitions 
Word Definition 
Hyperlink (Per Microsoft Help)  Colored and underlined text or graphic that 

you click to go to a file, a location in a file, or a Web page. 
 

 
 
Why would you use this? 

◘ To create a link to a web page or email address without using the address as 
the link. 

◘ To create a link from one part of the document to another.  You can use 
bookmarks for sections of the document and then create a topics page in 
which you can click on the topics to go directly to the page. 

◘ To create a link in one document to another document using any picture or 
text as the hyperlink. 

 
Step by Step 
 

What you do What happens 

1. Word automatically creates a 
hyperlink when you type the 
address of an existing Web page.   
 
If an address is not turned into a 
hyperlink, be sure that the 
automatic formatting of hyperlinks 
is turned on.  Go to Tools, 
AutoCorrect Options.  On the 
AutoFormat as you type tab, select 
the option for Internet and 
network paths with hyperlinks. 
 

 

2. Select the text or picture that you 
want to display as a hyperlink. 
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What you do What happens 

3. From the menu choose: 
Insert, Hyperlink 
 

The Insert Hyperlink box displays. 

 

4. To link to another document, click 
on the Current Folder button and 
then locate the file by using the file 
structure provided under the Look 
in drop down. 
 
Click on the OK button. 
 

 

5. To link to a web page that you 
have recently visited, click on the 
Browed Pages button and in the 
frame to the right, select the 
address. 
 
Click on the OK button. 
 

 

6. To enter a web address directly, 
click on the Existing File or Web 
Page button and in the Address 
field, enter the url. 
 
Click on the OK button. 
 

 

7. To direct the link to an e-mail 
address, click on the E-mail 
Address button and then enter the 
e-mail address in the E-mail 
address field. 
 
Click on the OK button. 
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What you do What happens 

8. To link the selection to a bookmark 
within the document, click on the 
Bookmark button.   
 
Note:  In order for this to work, 
you must first have the bookmarks 
created.   

The Select Place in Document box displays. 

 
 

9. Locate the bookmark under the 
Bookmarks heading and click on 
the OK button. 
 

 

10. On any of these options, you can 
adjust what the screen tip will say 
when the cursor is over the 
hyperlink.  
 
To adjust the screen tip, click on 
the screen tip button. 
 
 

The Set Hyperlink Screen Tip box displays. 

 
 

11. Enter the screen tip text and click 
on the OK button. 
 

 

12. To remove a hyperlink from the 
selection, select the hyperlink and 
return to the Insert Hyperlink box. 
 
Insert, Hyperlink 
 
Click on the Remove Link button.
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What you do What happens 

13. Tip:  The default method of using 
a hyperlink is Ctrl + Click.  You 
can change this to make it just a 
click.   
 
From the menu choose, 
Tools, Options 
 
On the Edit tab, clear the option for 
Use Ctrl + Click to follow 
hyperlink. 
 

 

 
 
Alternative Methods 

What you do What happens 

1. You can also use the Insert 
Hyperlink  icon on the 
Standard toolbar. 
 

 

2. The keyboard command of Ctrl + 
K opens the Insert Hyperlink box 
as well. 
 

 

 


